
 
 

บทที ่3 

 วธีิดาํเนินการวจัิย 
 

3.1 การคดัเลอืกพืน้ทีศึ่กษา 

สาํหรับขอ้กาํหนดในการเลือกพื้นท่ีศึกษาสาํหรับการศึกษาคร้ังน้ี จะคาํนึงถึงปัจจยัสาํคญั 3 
ปัจจยั ซ่ึงประกอบดว้ย 
 ปริมาณการจราจร พื้นท่ีท่ีจะทาํการศึกษาครอบคลุมปริมาณการจราจรของยานพาหนะทั้ง 

4 ชนิดประกอบดว้ย รถยนตส่์วนบุคคล รถจกัรยานยนต ์รถโดยสาร และรถบรรทุกขนาด
ใหญ่ 

 ลกัษณะของสายทางพื้นท่ีศึกษาตอ้งมีลกัษณะเป็นทางแยก ท่ีมีการควบคุมดว้ยสัญญาณ
ไฟจราจร เพื่อใหไ้ดข้อ้มูลการจราจรท่ีสามารถนาํไปใชใ้นการวิเคราะห์ได ้

 ลกัษณะความกวา้งของถนนท่ีเขา้ทางแยก ซ่ึงตอ้งคลอบคลุมถนนท่ีมีจาํนวนช่องจราจร
ต่างๆ ดงัน้ี  
 ถนนท่ีมีช่องทางจราจร 2 ช่องจราจรต่อ 2 ทิศทาง (ตวัแทนของถนนขนาดเลก็) 
 ถนนท่ีมีช่องทางจราจร 4 ช่องจราจรต่อ 2 ทิศทาง (ตวัแทนของถนนขนาดกลาง) 
 ถนนท่ีมีช่องทางจราจรมากกว่า 4 ช่องจราจรต่อ 2 ทิศทาง (ตวัแทนของถนนขนาด

ใหญ่) 
เม่ือพิจารณาขอ้กาํหนดในการคดัเลือกพื้นท่ีศึกษาสาํหรับใชใ้นการศึกษาและเก็บขอ้มูลภาคสนาม 
ไดพ้ื้นท่ีศึกษาดงัแสดงในตารางท่ี 3.1 และ รูปท่ี 3.1 
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ตารางที ่3.1 ตารางแสดงพ้ืนท่ีศึกษาท่ีนาํมาเป็นตวัแทนของการคดัเลือกพื้นท่ีศึกษา 

ลาํดับ
ที ่

ทางหลวง
หมายเลข 

ก.ม. ที ่ ช่ือสายทาง 

จาํนวนช่องจราจร 2 ช่อง (ต่อ 2 ทิศทาง) 
1 3127 4+775 แยกทางหลวงหมายเลข 315 – ต่อทางเทศบาลตาํบลพานทอง 

จาํนวนช่องจราจร 4 ช่อง (ต่อ 2 ทิศทาง) 
2 3051 120+450 คลองยาง-นครนายก 

จาํนวนช่องจราจรมากกวา่ 4 ช่อง (ต่อ 2 ทิศทาง) 

3 1 4+254 
แยกทางหลวงหมายเลข 1 (พยหุะคีรี) – ต่อทางองคก์ารบริหาร
ส่วนตาํบลเนินมะกอก 
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รูปที ่3.1 ตาํแหน่งพื้นท่ีท่ีไดท้าํการคดัเลือกเพ่ือเป็นตวัแทนการศึกษา 3 ทางแยก 

 

 

 N

สายทางที่ 1ทล. 3127 

สายทางที่ 3 ทล. 1  

สายทางที่ 2 ทล. 3051  
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3.2 การเกบ็รวบรวมข้อมูล 

การเก็บรวบรวมขอ้มูลให้ครบถว้นและถูกตอ้งแม่นยาํนั้นเป็นส่ิงสําคญัซ่ึงขอ้มูลท่ีถูกตอ้งจะ
ส่งผลต่อแบบจาํลองและผลลพัธ์ท่ีมีประสิทธิภาพ ในการวิจัยได้ทาํการลงพื้นท่ีศึกษาเพื่อเก็บ
รวบรวมขอ้มูล โดยจาํแนกขอ้มูลไดอ้อกเป็น 2 ประเภทคือ  

 

3.2.1 การเกบ็ข้อมูลทางกายภาพของทางแยก 

การเก็บขอ้มูลทางกายภาพประกอบดว้ยขอ้มูลเชิงเรขาคณิตของโครงข่ายถนนและทางแยกโดย
ขอ้มูลลกัษณะทางกายภาพของถนนและทางแยกนั้นประกอบดว้ย 
 จาํนวนช่องจราจร 
 ความกวา้งของช่องจราจร 
 ทิศทางการเดินรถของแต่ละช่องจราจร 
 ขนาดของเกาะกลาง เป็นตน้ 
 

3.2.2 การเกบ็ข้อมูลทางวศิวกรรมจราจร (Traffic Engineering Data Collection)  

ในขั้นตอนการเก็บขอ้มูลทางวิศวกรรมจราจรเป็นส่วนท่ีมีความสาํคญัมากเน่ืองจากขอ้มูลทางดา้น
วิศวกรรมนั้นสามารถบ่งบอกถึงลกัษณะความเป็นไปของการจราจร ณ ช่วงเวลานั้น แลว้ยงัแสดง
ให้เห็นถึงลกัษณะการขบัข่ีของผูส้ัญจรบนถนนและทางแยกอีกดว้ย ซ่ึงขอ้มูลเหล่าน้ีจะเป็นขอ้มูล
สาํคญัท่ีจะถูกนาํไปใชใ้นการสร้างแบบจาํลองเพ่ือวิเคราะห์หาผลลพัธ์ท่ีตอ้งการต่อไป โดยขอ้มูล
ทางวิศวกรรมจราจรท่ีทาํการเกบ็ขอ้มูลในงานวิจยัน้ีไดแ้ก่ 
 ปริมาณจราจรและประเภทยานพาหนะท่ีเขา้ทางแยก 
ซ่ึงในการเกบ็ขอ้มูลปริมาณจราจรและประเภทยานพาหนะนั้น ผูศึ้กษาไดท้าํการเกบ็โดยใชว้ิธีตั้ง
กลอ้งวีดิทศันเ์พื่อบนัทึกจากนั้นจึงนาํขอ้มูลท่ีไดจ้ากการบนัทึกของกลอ้งวีดิทศัน์มานบัเพื่อแยก
ประเภทของรถโดยการเปิดไฟลว์ีดิทศัน์ในคอมพิวเตอร์แลว้จึงนบัโดยการใชเ้คร่ืองมือนบัแบบกด 
(Counter) การสาํรวจเกบ็ขอ้มูลดา้นปริมาณจราจรบริเวณทางแยก (Intersection) เพื่อใชใ้นการ
วิเคราะห์ปัญหาการติดขดัของจราจรและอุบติัเหตุ รวมถึงใชใ้นการพฒันาแบบจาํลองสภาพจราจร  
สาํหรับประเภทของยวดยานท่ีจะทาํการสาํรวจจะสอดคลอ้งตามประเภทของยวดยานท่ีวิ่งอยูบ่น
ถนนในปัจจุบนั ยกตวัอยา่งเช่น 
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 รถจกัรยานยนต ์2 และ 3 ลอ้ 
 รถยนตน์ัง่ไม่เกิน 7 คน 
 รถยนตน์ัง่เกิน 7 คน / รถโดยสารขนาดเลก็ 
 รถโดยสารจนาดกลาง / รถโดยสารขนาดใหญ่ 
 รถบรรทุกขนาด 2 เพลา (6 ลอ้) 
 รถบรรทุกขนาด 3 เพลา (10 ลอ้) 
 รถบรรทุกขนาดมากกวา่ 3 เพลา (พว่งและก่ึงพว่ง) 

สาํหรับประเภทของยวดยานท่ีจะทาํการสาํรวจจะสอดคลอ้งตามประเภทของยวดยานท่ีวิ่งอยูบ่น
ถนนในปัจจุบนั ดงัน้ี 

- การตรวจนับปริมาณจราจรบนช่วงถนน (Mid-Block Counts; MB)  

การสาํรวจปริมาณจราจรบนช่วงถนนโดยแยกประเภทยานพาหนะและทิศทางการเดินทางโดย
วตัถุประสงคข์องการสาํรวจปริมาณจราจรบนช่วงถนน คือ เพื่อใชเ้ป็นขอ้มูลในการปรับแก้
แบบจาํลองจราจรและขนส่งใหเ้ป็นปัจจุบนั โดยในการสาํรวจปริมาณจราจรบนช่วงถนน ท่ีปรึกษา
จะไดน้บัปริมาณจราจรโดยแยกทิศทางของรถท่ีวิ่งผา่นในแต่ละทิศทางของช่วงถนน ท่ีปรึกษาจะ
แยกประเภทของยานพาหนะออกเป็นประเภทต่างๆ ใหส้อดคลอ้งตามประเภทของยวดยานท่ีวิ่งอยู่
บนถนนในปัจจุบนัและดาํเนินการใหเ้ป็นไปตามหลกัเกณฑด์า้นวิศวกรรมจราจร  

- การสํารวจปริมาณจราจรทีท่างแยก (Traffic Movement Counts; TMC) 

การสาํรวจปริมาณการจราจรบนทางแยกทาํใหท้ราบถึงสดัส่วนการเดินทางในทิศทางต่างๆ ท่ี
เกิดข้ึน ณ ทางแยกนั้นๆ ซ่ึงขอ้มูลในส่วนน้ีมีความจาํเป็นอยา่งยิง่ในการจดัการจราจรบริเวณทาง
แยก เช่น การจดัระบบสญัญาณไฟจราจร และการคาํนวณความล่าชา้จากการหยดุท่ีบริเวณทางแยก 
สาํหรับการสาํรวจน้ี ท่ีปรึกษาจะทาํการนบัปริมาณจราจรโดยแยกทิศทางของรถท่ีวิ่งผา่นในแต่ละ
ทิศทาง (Approach) ของทางแยก โดยจะทาํการสาํรวจในวนัเดียวกนักบัการสาํรวจปริมาณจราจร
บนช่วงถนน (Mid-Block Classified Counts)  
 ความเร็วขณะเล้ียวและความเร็วการไหลอิสระก่อนเขา้ทางแยก 
การเกบ็ขอ้มูลความเร็วขณะเล้ียวและความเร็วการไหลอิสระของรถแต่ละประเภทโดยใชเ้คร่ืองมือ 
Radar Speed Gun โดยขอ้มูลความเร็วขณะเล้ียวของรถแต่ละประเภทนั้นผูศึ้กษาไดท้าํการเกบ็ทุก
ทิศทางของทางแยกเพ่ือใหส้ะทอ้นถึงความเร็วขณะเล้ียวของกายภาพของถนนแต่ละทิศทางท่ี
แตกต่างกนั การสาํรวจน้ี มีวตัถุประสงคเ์พื่อใชเ้ป็นขอ้มูลในการปรับ Speed Flow Curve ใน
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แบบจาํลองการแจกแจงการเดินทาง (Traffic Assignment) ใหมี้ความเหมาะสมกบัลกัษณะ
พฤติกรรมของผูข้บัข่ีรถยนต ์ลกัษณะทางกายภาพของถนน และลกัษณะเฉพาะของสภาพการจราจร
ในพื้นท่ีโครงการ รวมทั้งเป็นขอ้มูลประกอบในการปรับแกแ้บบจาํลองจราจรและขนส่งใหเ้ป็น
ปัจจุบนั 
 
 รอบและระยะสญัญาณไฟจราจร  
การเกบ็ขอ้มูลลกัษณะสญัญาณไฟจราจรท่ีทางแยกจะตอ้งมีองคป์ระกอบดงัต่อไปน้ี  

- Cycle หรือ รอบสัญญาณไฟ หมายถึง หน่ึงรอบของสัญญาณไฟจราจรCycle Length 
หมายถึง ระยะเวลา  (วินาที) ท่ีใชส้าํหรับ 1 รอบ 

- Interval หมายถึง ช่วงของเวลาท่ีช่วงสญัญาณไฟคงเดิม 
- Change Interval หมายถึง ช่วงเวลาไฟเหลือง ในทิศทางท่ีกาํหนด ซ่ึงเป็นช่วงระหว่าง

เปล่ียนจากช่วงไฟเขียวเป็นไฟแดง ช่วงเวลาไฟเหลืองเป็นช่วงเวลาท่ีให้สําหรับรถท่ีไม่
สามารถหยดุไดอ้ยา่งปลอดภยัสามารถเขา้สู่ทางแยกไดอ้ยา่งปลอดภยั  

- Clearance Interval เป็นส่วนหน่ึงของช่วงการเปล่ียนจากไฟเขียวเป็นไฟแดง ในทิศทางท่ี
กาํหนด โดยในระหว่าง Clearance Interval ยวดยานในทุกทิศทางจะไดรั้บสัญญาณไฟแดง 
โดย Clearance Interval เป็นช่วงเวลาท่ีใหส้าํหรับยวดยานท่ีเขา้สู่ทางแยกในช่วงเวลาไฟ
เหลือง สามารถผา่นทางแยกไปได ้ก่อนท่ีจะปล่อยรถในทิศทางท่ีขดักนั (Conflict)  

- Green Interval แต่ละ movement จะไดรั้บ 1  Green Interval หรือ 1  สัญญาณไฟเขียว ในแต่
ละรอบสญัญาณ 

- Red Interval แต่ละ movement จะไดรั้บ 1  Red Interval หรือ 1  สัญญาณไฟเขียว ในแต่ละ
รอบสญัญาณ 

- Phase หน่ึงเฟสสญัญาณไฟจะประกอบไปดว้ย ไฟเขียว ไฟเหลือง และ Clearance Interval 

 สภาพจราจรและพฤติกรรมท่ีเก่ียวขอ้ง 
 การศึกษาน้ีจาํเป็นตอ้งตรวจสอบความสามารถการรองรับปริมาณจราจรของถนน โดยจะ
พิจารณาในรูปของระดบัการใหบ้ริการ (Level of Service: LOS) ซ่ึงเป็นวิธีการในการวดัเชิงคุณภาพ
ของการสญัจรของยานพาหนะบนถนน ภายใตข้อ้จาํกดัของสภาพการจราจร (Traffic Conditions) 
และสภาพถนน (Roadway Conditions) โดยการรับรู้ในรูปของความสะดวกสบายและรวดเร็วของ
การสญัจร การวิเคราะห์ระดบัการใหบ้ริการของถนนเป็นการตรวจสอบขีดความสามารถในการ
ใหบ้ริการแก่จาํนวนยานพาหนะของถนนท่ีทาํการศึกษาในช่วงเวลาใดเวลาหน่ึง สภาพการจราจรท่ี
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นาํมาพิจารณาเป็นลกัษณะหรือองคป์ระกอบของกระแสจราจรท่ีมีผลต่อการใหบ้ริการของถนน 
เช่น ปริมาณการจราจร (Traffic Volume) อตัราการไหล (Flow Rate) ประเภทของยานพาหนะ ส่วน
สภาพถนนจะครอบคลุมลกัษณะทางดา้นเรขาคณิตท่ีมีผลต่อการเปล่ียนแปลงในกระแสจราจร เช่น 
จาํนวนช่องจราจร ความกวา้งของช่องจราจรและไหล่ทาง ความเร็วในการออกแบบ  
 
 การสาํรวจความล่าชา้  
  เม่ือกล่าวถึงความล่าชา้ โดยส่วนใหญ่จะหมายถึง ความล่าชา้อนัเกิดจากการหยดุ (Stopped 
delay) ของยวดยาน และเน้ือหาท่ีจะกล่าวถึงในหวัขอ้น้ี จะพิจารณาความล่าชา้อนัเกิดจากการหยดุ
บริเวณทางแยก (Intersection stopped delay) เป็นหลกัความล่าชา้อนัเกิดจากการหยดุ (มีหน่วยเป็น 
วินาทีต่อคนั หรือ sec/veh) เป็นตวัช้ีวดัท่ีสาํคญัค่าหน่ึงท่ีบ่งบอกประสิทธิภาพในการรองรับปริมาณ
จราจรและระดบัการใหบ้ริการของทางแยก  
 การสาํรวจความล่าชา้ของงานวิจยัน้ีใชว้ิธี Stopped Time Delay Method ซ่ึงวิธีน้ีจะใหค่้าของ
ความล่าชา้หยดุ (Stopped delay) ท่ีทางแยกโดยไม่รวมเวลาท่ีสูญเสียไปเน่ืองจากเวลาท่ีรถชะลอเพ่ือ
หยดุหรือเร่งเคร่ืองเพ่ือออกรถ ซ่ึงการเกบ็ขอ้มูลมีขั้นตอนดงัน้ี 

1.  นบัจาํนวนรถบนทางแยกท่ีหยดุทุกๆ ช่วงเวลา 15 วินาที ของแต่ละนาทีเป็นเวลา 1 ชัว่โมง 
โดยนบัเฉพาะนอกชัว่โมงเร่งด่วน 

2.  นบัจาํนวนรถท่ีหยดุ และไม่หยดุ เพื่อขบัขา้มทางแยกทุกนาทีตลอดระยะเวลาตามขั้นตอนท่ี 
1 

3.  นาํขอ้มูลท่ีไดจ้ากการสาํรวจมาคาํนวณหาค่าความล่าชา้ท่ีเกิดข้ึน 
 
 

3.3 การสรุปข้อมูลทางด้านจราจรเบือ้งต้น 

จากการเก็บขอ้มูลทางกายภาพและทางวิศวกรรมจราจรจากการสํารวจเพื่อนาํไปใชใ้นการ
ออกแบบและสร้างแบบจาํลองในการหาค่า สามารถสรุปขอ้มูลไดด้งัน้ี 
 ปริมาณจราจรและประเภทยานพาหนะในแต่ละทิศทางการเดินรถท่ีทางแยก 
 การสาํรวจความล่าชา้  
 ความเร็วการไหลอิสระก่อนเขา้ทางแยก 
 รอบและระยะสญัญาณไฟจราจร 
 การเกบ็ขอ้มูลทางกายภาพ 
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3.4 การสร้างแบบจําลองตามสภาพจริงโดยโปรแกรม VISSIM 
การออกแบบแบบจาํลองท่ีแสดงผลตามสภาพจริงเป็นตน้แบบในการนาํแบบจาํลองไปพฒันาเพื่อ
ประยกุตใ์ชใ้นการออกแบบแบบจาํลองในการหาค่าความจุของทางเช่ือม โดยมีขั้นตอนดงัต่อไปน้ี 
 

3.4.1 การนําเข้าภาพพืน้หลงั 
ในขั้นตอนน้ีทาํไดโ้ดยทาํการบนัทึกภาพถ่ายทางอากาศจากโปรแกรม Google Earth และนาํไปจดั
มาตราส่วนในโปรแกรม Auto CAD จากนั้นจึงนาํเขา้ไฟล ์.dwg สู่โปรแกรม VISSIM โดยมี
ขั้นตอนคือการเขา้สู่คาํสั่ง View> Background > Edit > Load ดงัแสดงในรูปท่ี 3.2 และปรากฏภาพ
พื้นหลงัข้ึนมาในโปรแกรม VISSIM ดงัแสดงในรูปท่ี 3.3 ซ่ึงภาพพื้นหลงันั้นจะเป็นพื้นฐานในการ
สร้างแบบจาํลองต่อไป 

 

รูปที ่3.2 ภาพแสดงคาํสัง่การนาํเขา้ภาพถ่ายทางอากาศ 
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รูปที ่3.3 ภาพแสดงการนาํเขา้ภาพพื้นหลงั (Background) ตาํแหน่งแยกบา้นนา จ.นครนายก 

           โดยใชโ้ปรแกรม VISSIM 5.4 
 

3.4.2  การสร้างโครงข่ายของแบบจาํลอง 

 การสร้างลิงคคื์อการสร้างแนวถนนซ่ึงแต่ละลิงคจ์ะสามารถกาํหนดจาํนวนช่องจราจร ความ
กวา้ง และลกัษณะทัว่ไปของถนนได ้ซ่ึงแต่ละลิงคจ์ะถูกเช่ือมต่อกนัดว้ยคอนเนคเตอร์ ทาํให้เกิด
โครงข่ายของถนนโดยในขั้นตอนการสร้างลิงคน์ั้นสามารถกาํหนดองคป์ระกอบของถนนไดโ้ดย
การกาํหนดในคาํสัง่ต่างๆดงัน้ี 

 ช่ือของลิงคท่ี์สร้าง (Name) 
 จาํนวนช่องจราจร (No. of Lanes) 
 ชนิดของพฤติกรรมของการใชถ้นน (Behavior Type) โดยพฤติกรรมของผูใ้ชถ้นนชนิดต่างๆ
สามารถเขา้ไปปรับแกค่้าไดใ้นคาํสัง่ Base Data > Driving Behavior 
 ชนิดการแสดงผล (Display Type) 
 ความกวา้งของช่องจราจร (Lane Width) 
 ความกวา้งของช่องจราจรท่ีมีขนาดไม่คงท่ี (Various Lane Widths) 
 การปิดช่องจราจร (Lane Closure) 
 การหา้มเปล่ียนช่องจราจร (No Lane Change) 
 การเปล่ียนทิศทางของถนน (Change Direction) 
 ใชใ้นการสญัจรของคนเดิน (Use as Pedestrian Area) 
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แสดงไดด้งัในรูปท่ี 3.4 และ รูปท่ี 3.5 

 
รูปที ่3.4 ภาพแสดงโครงข่ายของถนน 

 

 
รูปที ่3.5 ภาพท่ีไดจ้ากการสร้างลิงคแ์ละคอนเนคเตอร์ 

 

3.4.3  การกาํหนดความเร็วของผู้ใช้ถนน  (Design Speed) 

ในขั้นตอนน้ีจะกาํหนดความเร็วของผูใ้ชถ้นนของถนนแต่ละช่วงซ่ึงไดท้าํการเก็บขอ้มูลมาจริงของ
รถแต่ละประเภทดังเช่นท่ีได้สรุปขอ้มูลมา  โดยขอ้มูลท่ีได้มานั้ นจะถูกนํามาเขียนในรูปของ
เปอร์เซ็นตแ์ละเปอเซ็นตส์ะสมดงัแสดงในตารางท่ี3.3 จากนั้นจึงนาํมาวาดออกมาในเชิงแผนภูมิ
ของโปรแกรม VISSIM โดยใชคาํสั่ง Base Data > Distribution > Design Speed ดงัแสดงในรูปท่ี 
3.27 
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รูปที ่3.6 แสดงการวาดแผนภูมิระหวา่งความเร็วและเปอร์เซ็นตส์ะสม 

 

3.4.4  การกาํหนดสัดส่วนของการจราจร (Vehicle Compositions) 

การกาํหนดสัดส่วนของการจราจรเป็นการกาํหนดชุดขอ้มูลของรถท่ีวิ่งบนถนนแต่ละเส้นว่าบน
ถนนเส้นนั้นมีสัดส่วนของปริมาณการจราจรเท่าใดและมีความเร็วท่ีใชข้องรถแต่ละชนิดเท่าไหร่
โดยการเลือกความเร็วจาก ขอ้มูลความเร็วท่ีไดส้ร้างข้ึนในขั้นตอน 3.4.3โดยใชค้าํสั่ง Traffic > 
Vehicle Compositions ดงัแสดงในรูปท่ี 3.7 
 

 
รูปที ่3.7 แสดงการกาํหนดสดัส่วนการจราจรในโปแกรม VISSIM 
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3.4.5  การนําเข้าปริมาณการจราจร (Vehicle Inputs)  

การนาํเขา้ปริมาณการจราจรเป็นการกาํหนดปริมาณการจราจรของรถชนิดต่างๆเพื่อเขา้สู่ถนนเส้นท่ี
ตอ้งการ โดยการใชค้าํสั่ง Vehicle Inputsจากนั้นไปเลือกท่ีถนนท่ีไดท้าํการเก็บขอ้มูลมาเพื่อเป็นตน้
ทางท่ีรถวิ่งเขา้ดงัแสดงในรูปท่ี 3.8 
 

 
รูปที ่3.8 แสดงนาํเขา้ปริมาณการจราจรในโปรแกรม VISSIM 

 

3.4.6 การกาํหนดลกัษณะพฤตกิรรมการขบัขี ่ 

- การสร้างเส้นทางวิ่งของยานพาหนะ (Routes):เป็นขั้นตอนในการกาํหนดเส้นทางในการ
เดินทาง และ สัดส่วนปริมาณจราจรของยานพาหนะในแต่ละทิศทางของพ้ืนท่ีท่ีทาํการศึกษา ซ่ึง
ดาํเนินการโดยใชค้าํสัง่ Routes  
- สร้างพืน้ที่ลดความเร็วของยานพาหนะ (Reduce Speed Areas):เป็นขั้นตอนในการ

กาํหนดพื้นท่ีบริเวณต่างๆท่ียานพาหนะจาํเป็นตอ้งลดความเร็วลง เช่น จุดเล้ียวรถ จุดกลบัรถ เป็น
ตน้ ซ่ึงดาํเนินการโดยใชค้าํสัง่ Reduce Speed Areas  
- การสร้างพืน้ที่ระวังเน่ืองจากการตัดกันของถนน (Conflict Areas)เป็นขั้นตอนในการ

กาํหนดพื้นท่ีบริเวณต่างๆท่ียานพาหนะตอ้งระวงั เน่ืองจากมีจุดขดัแยง้ของถนน ซ่ึงดาํเนินการโดย
ใชค้าํสัง่ Conflict Areas ดงัแสดงในรูปท่ี 3.30 และสามารถกาํหนดองคป์ระกอบของพื้นท่ีระวงัของ
ยานพาหนะ จากคาํสัง่ยอ่ยต่างๆ ดงัน้ี 
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- แถบสีเขียว หมายถึง เส้นทางหลกั โดยรถท่ีวิ่งมาทิศทางน้ีจะไดรั้บคาํสั่งให้ผา่นได้
ก่อน 

- แถบสีแดง หมายถึง เส้นทางรอง โดยรถท่ีวิ่งมาทิศทางน้ีจะไดรั้บคาํสั่งให้ผ่านได้
หลงัจากท่ีรถในทิศทางหลกัไม่กีดขวาง 
 

 
รูปที ่3.9 การสร้างพื้นท่ีระวงัเน่ืองจากการตดักนัของถนน (Conflict Areas) 

 
3.4.7 การกาํหนดค่าสัญญาณไฟจราจร (Signal Control) 
การกาํหนดค่าสญัญาณไฟจราจรในโปรแกรม VISSIMสามารถดาํเนินการโดยใชค้าํสัง่ Signal 
Control ดงัแสดงในรูปท่ี 3.31 

 
รูปที ่3.10 การสร้างรอบสญัญาณไฟจราจร (Signal Control) โดยใชโ้ปรแกรม VISSIM 5.40 
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3.4.8 การตดิตั้งระบบสัญญาณไฟจราจร (Signal Heads) 

เป็นขั้นตอนในการติดตั้งเสน้กาํหนดเขตรอสญัญาณไฟจราจรในพื้นท่ีบริเวณต่างๆท่ียานพาหนะ
ตอ้งระวงั ซ่ึงดาํเนินการโดยใชค้าํสัง่ Signal Heads ดงัแสดงในรูปท่ี 3.11 

 
รูปที ่3.11 การติดตั้งระบบสญัญาณไฟจราจร (Signal Heads) โดยใชโ้ปรแกรม VISSIM 5.40 

 

3.4.9 การกาํหนดค่าทีต้่องการเกบ็ข้อมูล (Evaluation) 

เป็นขั้นตอนในการกาํหนดคาํสัง่ในการเกบ็ขอ้มูลต่างๆท่ีตอ้งการนาํมาวิเคราะห์ ยกตวัอยา่งเช่นการ
หาความเร็วเฉล่ีย (Average Speed), ความเร่งเฉล่ีย (Average Acceleration), ระยะทางในการ
เดินทางทั้งหมดท่ีเกิดข้ึน (Total Distance) หรือความยาวแถวคอยเป็นตน้ ซ่ึงดาํเนินการโดยใชค้าํสัง่ 
Evaluation > File ดงัแสดงในรูปท่ี 3.12 
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รูปที ่3.12 การกาํหนดค่าท่ีตอ้งการเกบ็ขอ้มูล (Evaluation) โดยใชโ้ปรแกรม VISSIM 5.40 

 

3.4.10 การประมวลผลแบบจาํลอง (Run Simulation Process) 

เป็นขั้นตอนในการดาํเนินแบบจาํลองเพื่อหาค่าต่างๆท่ีต้องการวิเคราะห์โดยสามารถกาํหนด
รายละเอียดในการประมวลผลแบบจาํลองต่างๆไดย้กตวัอย่างเช่น ความเร็วในการประมวลผล
แบบจาํลอง หรือระยะเวลาในการประมวลผลแบบจาํลองเป็นตน้ ซ่ึงแสดงผลในรูปแบบภาพสอง
และสามมิติดงัแสดงในรูปท่ี 3.13ถึงรูปท่ี 3.14 

 
รูปที ่3.13 การประมวลผลแบบจาํลองในรูปแบบสองมิติ โดยใชโ้ปรแกรม VISSIM 5.40 
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รูปที ่3.14 การประมวลผลแบบจาํลองในรูปแบบสามมิติ โดยใชโ้ปรแกรม VISSIM 5.40 

จากนั้นเม่ือไดผ้ลจากการประมวลผลแบบจาํลองมาเปรียบเทียบกบัขอ้มูลท่ีเกบ็มาจากพื้นท่ีศึกษา 
หากเปรียบเทียบผลลพัธ์ท่ีไดจ้ากแบบจาํลองไม่ตรงกบัขอ้มูลท่ีไดท้าํการเกบ็มาจริงจะตอ้งมีการ
แกไ้ขแบบจาํลองแลว้จึงทาํการประมวลผลซํ้าตั้งแต่ตน้ดงักระบวนการท่ีไดท้าํมาขา้งตน้ 
 

3.5 การปรับเทยีบและทวนสอบแบบจําลอง 

การปรับเทียบและทวนสอบแบบจาํลองคือการตรวจสอบแบบจาํลองเพ่ือวดัความถูกตอ้งและ
น่าเช่ือถือของแบบจาํลองท่ีไดส้ร้างข้ึนและปรับแกใ้นส่วนของขอ้มูลท่ีส่งผลใหพ้ฤติกรรมการขบัข่ี
ในแบบจาํลองคลาดเคล่ือน โดยในหัวขอ้การปรับเทียบและทวนสอบแบบจาํลองมีขั้นตอนคือ การ
ตรวจสอบความคลาดเคล่ือนของแบบจําลอง การปรับเทียบแบบจําลองและการทวนสอบ
แบบจาํลอง 
 

3.5.1 การตรวจสอบความคลาดเคลือ่นของแบบจาํลอง (Error Checking Process) 

การตรวจสอบความคลาดเคล่ือนของแบบจาํลอง คือการตรวจสอบความถูกตอ้งเบ้ืองตน้เพื่อของ
แบบจาํลองโดยแบ่งไดเ้ป็น 2 ส่วนดงัน้ี 
- การทบทวนขอ้มูลนาํเขา้ (Data Input) คือการตรวจสอบขอ้มูลพื้นฐานท่ีไดท้าํการนาํเขา้
แบบจาํลองท่ีสร้างข้ึน เช่น ลกัษณะทางกายภาพของถนน ประเภทของถนน การเช่ือมต่อของช่วง
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ถนน ปริมาณการจราจรและสัดส่วนของปริมาณการจราจร เป็นตน้ เพื่อใหม้ัน่ใจว่าแบบจาํลองไม่มี
ความผดิพลาดในส่วนของการนาํเขา้ขอ้มูล 
- การทบทวนการแสดงผลจากแบบจาํลองภาพเคล่ือนไหว เพื่อให้เห็นถึงพฤติกรรมการขบัข่ีท่ีไม่
เป็นธรรมชาติของแบบจาํลองเบ้ืองตน้และพร้อมท่ีจะนาํไปสู่ขั้นตอนการปรับเทียบแบบจาํลอง
อยา่งละเอียด 
 

3.5.2 การปรับเทยีบแบบจาํลอง (Model Calibration) 

การปรับเทียบแบบจาํลองคือกระบวนการปรับแกค่้าตวัแปรบางตวัในแบบจาํลองเพ่ือใหไ้ดผ้ลลพัธ์
และพฤติกรรมของแบบจาํลองท่ีมีความเหมือนจริง โดยผลท่ีได้จากแบบจาํลองจะถูกนํามา
ตรวจสอบตามขั้นตอนการทวนสอบแบบจําลองโดยมีเกณฑ์ในการปรับเทียบแบบจําลอง 
(Calibration Target and Criteria) ในการศึกษาโดยไดเ้ลือกหลกัเกณฑต์าม DMRB ซ่ึงท่ีไดรั้บการ
ยอมรับและถูกใชก้นัอยา่งแพร่หลายในการปรับเทียบแบบจาํลองระดบัจุลภาค โดยในการศึกษาน้ี
ไดใ้ชด้ชันีช้ีวดัดงัต่อไปน้ี  
 ปริมาณการจราจร 
 ความเร็ว 

นอกจากน้ียงัมีการปรับเทียบพฤติกรรมการขบัข่ี (Driving Behavior Calibration)โดยทาํการ
ปรับเทียบพฤติกรรมต่างๆให้สอดคลอ้งกบัขอ้มูลท่ีไดท้าํการสาํรวจมากท่ีสุด เช่น การลดความเร็ว 
การเปล่ียนช่องจราจร การวิ่งตามกนัของกระแสจราจรและการตดัเขา้ถนนสายหลกั เป็นตน้ 

 
รูปที ่3.15 แสดงตวัอยา่งการปรับแกร้ะยะการลดความเร็ว 
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3.5.3 การทวนสอบแบบจาํลอง (Model Validation) 

การทวนสอบแบบจาํลองคือการตรวจสอบความถูกตอ้งของแบบจาํลองซ่ึงเป็นขั้นตอนท่ีเกิดควบคู่
กนัไปกบัขั้นตอนการปรับแกแ้บบจาํลอง ซ่ึงหากผลลพัธ์ท่ีไดจ้ากแบบจาํลองมีค่าความถูกตอ้งไม่
ผา่นตามเกณฑท่ี์ไดก้าํหนดไว ้จะตอ้งทาํการปรับแกแ้บบจาํลองใหม่เพื่อใหไ้ดผ้ลลพัธ์ท่ีอยูใ่นเกณฑ์
ท่ียอมรับไดจึ้งจะถือวา่แบบจาํลองนั้นมีความน่าเช่ือถือ โดยมีดชันีการเปรียบเทียบความถูกตอ้งของ
แบบจาํลองตาม DMRB ดงัแสดงในตารางท่ี 3.2 

ตารางที ่3.2 แสดงดชันีช้ีวดัความถูกตอ้งของแบบจาํลองระดบัจุลภาค 
ตวัช้ีวดัการปรับเทยีบ เกณฑ์การปรับเทยีบ เป้าหมายการปรับเทยีบ 

ปริมาณจราจร GEH<5 
>85% ของกรณีทั้งหมดท่ีทาํการ
ปรับเทียบ 

เวลาในการเดินทาง 
±15% (หรือไม่เกิน 1 นาทีถา้มีความคลาดเคล่ือน

สูงกวา่ 15%) 
>85% ของกรณีทั้งหมดท่ีทาํการ
ปรับเทียบ 

ความเร็วในการเดินทาง ±20% 
>85% ของกรณีทั้งหมดท่ีทาํการ
ปรับเทียบ 

ความยาวแถวคอย 
±20% (หรือ ±5 คนัเม่ือความยาวแถวคอยท่ี

สาํรวจไม่เกิน 10 คนั หรือ ±7 คนัเม่ือความยาว
แถวคอยท่ีสาํรวจไม่เกิน 20 คนั) 

>85% ของกรณีทั้งหมดท่ีทาํการ
ปรับเทียบ 

 

 
  2/

2

CV

CV
GEH





      (3-

1) 

 เม่ือ V คือ ปริมาณจราจรท่ีไดจ้ากผลการจาํลอง 
  C คือ ปริมาณจราจรท่ีไดจ้ากผลการสาํรวจในสนาม 

-  การทวนสอบปริมาณจราจร 
การทวนสอบปริมาณจราจรจากแบบจาํลอง ในการศึกษาน้ีจะยอมใหค่้า GEH ของปริมาณ

การจราจรท่ีผา่นทางเช่ือมคลาดเคล่ือนไดไ้ม่เกิน 5 % 
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 -  การทวนสอบค่าความเร็ว 
ในการทวนสอบค่าความเร็วไดเ้ลือกทวนสอบค่า ความเร็วเฉล่ียของทางเช่ือมบริเวณช่วงโคง้ท่ี

มีรัศมีความโคง้ตํ่าท่ีสุด โดยค่าความเร็วเฉล่ียจากแบบจาํลองจะตอ้งมีความคลาดเคล่ือนไม่เกิน 20 
% ของความเร็วเฉล่ียท่ีไดท้าํการเกบ็ขอ้มูลภาคสนามมา 

 

3.5.4  การสอบเทยีบความล่าช้า 

เน่ืองจากในการศึกษาน้ีไดใ้ชค่้าความล่าชา้ท่ีทางแยกในการวิเคราะห์หาค่าเทียบเท่ารถยนตน์ัง่ส่วน
บุคคล จึงจาํเป็นท่ีจะตอ้งมีการสอบเทียบความล่าชา้ท่ีไดจ้ากแบบจาํลองกบัค่าท่ีวดัไดจ้ากภาคสนาม 
ความคลาดเคล่ือนไม่เกิน 20 % ของความล่าชา้ท่ีไดท้าํการเกบ็ขอ้มูลภาคสนามมา 
 

3.6 การประยุกต์ใช้แบบจําลองในการหาค่าความสามารถในการรองรับปริมาณ
จราจรต่อไฟเขยีวของทางแยก 

เน่ืองจากการวิเคราะห์หาค่าความสามารถในการรองรับปริมาณจราจรต่อไฟเขียวของทางแยกจาก
ขอ้มูลท่ีเก็บไดท่ี้สนามนั้นค่อนขา้งยาก ในการศึกษาน้ีไดน้าํเสนอการประยกุตใ์ชแ้บบจาํลองระดบั
จุลภาคซ่ึงไดส้ร้างโดยโปรแกรม VISSIM ในการวิเคราะห์หาค่าความสามารถในการรองรับปริมาณ
จราจรต่อไฟเขียวของทางแยกต่างๆซ่ึงมีลกัษณะทางกายภาพและพฤติกรรมการขบัข่ีท่ีแตกต่างกนั 
โดยการหาค่าความสามารถในการรองรับปริมาณจราจรต่อไฟเขียวของทางแยกในงานวิจยัน้ีไดท้าํ
การปรับเพิ่มปริมาณจราจรนาํเขา้ (Vehicle Input) โดยเร่ิมตน้จากการนาํเขา้ปริมาณจราจร 100 คนั
ต่อชัว่โมงต่อช่องจราจร และเพิ่มปริมาณจราจรในแต่ละสถานการณ์ สถานการณ์ละ 100 คนัต่อ
ชัว่โมงต่อช่องจราจรไปจนถึงปริมาณจราจร 1000 คนัต่อชัว่โมงต่อช่องจราจรเพ่ือทาํการหาปริมาณ
จราจรท่ีมากท่ีสุดท่ีทางแยกนั้นๆสามารรองรับได ้

3.7 พฒันาแบบจําลองในสถานการณ์ต่างๆ 
การพฒันาแบบจาํลองในสถานการณ์ต่างๆคือ การนาํขอ้มูลจากแบบจาํลองปัจจุบนัท่ีไดส้ร้างและ
ปรับเทียบพฤติกรรมการขบัข่ีท่ีมีอยู่เดิม มาพฒันาให้เป็นแบบจาํลองใหม่ท่ีอยู่ในสถานการณ์
เดียวกนัหรือเรียกไดว้่าเป็นตวัแปรควบคุมเพื่อเปรียบเทียบเฉพาะผลกระทบจากตวัแปรตน้เพียง
อย่างเดียว โดยในงานวิจยัน้ีไดท้าํการกาํหนดตวัแปรตน้ 2 ตวัแปร อนัไดแ้ก่ ปริมาณจราจรท่ีเขา้สู่
ทางแยก (คนัต่อชัว่โมง) และสดัส่วนประเภทยานพาหนะท่ีเขา้สู่ทางแยก 
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- ปริมาณจราจรทีเ่ข้าสู่ทางแยก 

ในการวิเคราะห์หาค่าเทียบเท่ารถยนตส่์วนบุคคลในการศึกษาน้ี จะทาํการพฒันาแบบจาํลองเพ่ือ

จาํลองสถานการณ์ในแต่ละค่าของปริมาณจราจรท่ีเขา้สู่ทางแยก และสดัส่วนประเภทยานพาหนะ

ต่างๆ โดยปริมาณจราจรท่ีเขา้สู่ทางแยกนั้นจะประกอบไปดว้ย 3 รูปแบบไดแ้ก่ 

 ปริมาณจราจรร้อยละ 50 ของความสามารถในการรองรับปริมาณจราจรต่อไฟเขียวของทาง

แยก 

 ปริมาณจราจรร้อยละ 75 ของความสามารถในการรองรับปริมาณจราจรต่อไฟเขียวของทาง

แยก 

 ปริมาณจราจรร้อยละ 100 ของความสามารถในการรองรับปริมาณจราจรต่อไฟเขียวของทาง
แยก 
 
- สัดส่วนประเภทยานพาหนะทีเ่ข้าสู่ทางแยก 

ในการศึกษาน้ีไดท้าํการจาํแนกยานพาหนะออกเป็น 4 ประเภทประกอบดว้ย รถยนต์ส่วนบุคคล 
รถจกัรยานยนต ์รถโดยสาร และรถบรรทุกโดยในการพฒันาแบบจาํลองเพ่ือจาํลองสถานการณ์ใน
แต่ละค่าของปริมาณจราจรท่ีเขา้สู่ทางแยกจะประกอบไปดว้ยสัดส่วนของประเภทยานพาหนะท่ีเขา้
สู่ทางแยกรูปแบบต่างๆทั้งหมด 10รูปแบบ ดงัแสดงในตารางท่ี 3.3 
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ตารางที ่3.3 สดัส่วนของประเภทยานพาหนะท่ีเขา้สู่ทางแยกรูปแบบต่างๆ 

รูปแบบ 
สดัส่วนของประเภทยานพาหนะ 

รถยนตส่์วน
บุคคล 

รถจกัรยานยนต ์ รถโดยสารขนาด
ใหญ่ 

รถบรรทุกขนาด
ใหญ่ 

1 100    
2 80 20   
3 80  20  
4 80   20 
5 60 40   
6 60  40  
7 60   40 
8 40 60   
9 40  60  
10 40   60 

 

3.8 การวเิคราะห์หาค่าเทยีบเท่ารถยนต์ส่วนบุคคล  
การวิเคราะห์หาค่าเทียบเท่ารถยนตส่์วนบุคคล หรือ Passenger Car Equivalent (PCE) ในงานวิจยัน้ี
ไดใ้ชว้ิธีการวิเคราะห์หาค่าเทียบเท่ารถยนตส่์วนบุคคลจากความล่าชา้ (Delay-Based PCE) ในการ
วิเคราะห์โดยแนวคิดในการวิเคราะห์หาค่าเทียบเท่ารถยนต์ส่วนบุคคลจากความล่าช้าคือ การ
เปรียบเทียบความล่าชา้ท่ีเปล่ียนแปลงไปอนัเน่ืองมาจากการผสมของยานพาหนะประเภทอ่ืนๆ กบั
ความล่าชา้พื้นฐานของรถยนตน์ั่งส่วนบุคคล โดยสามารถเขียนเป็นสมการณ์ทางคณิตศาสตร์ได้
ดงัน้ี 
 

            
0

1_
d

d
PCED ijk

ijk


               (3-2) 

โดยท่ี 

ijkPCED _  =    ค่าเทียบเท่ารถยนตส่์วนบุคคลจากความล่าชา้สาํหรับยานพาหนะประเภท i 
        ท่ีสภาวะสดัส่วนปริมาณจราจรต่อการไหลอ่ิมตวั j และท่ีสภาวะสดัส่วน 
         ยานพาหนะต่อรถยนตน์ัง่ส่วนบุคคล k 
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ijkd   =    ความล่าชา้ทั้งหมดท่ีเปล่ียนแปลงไปอนัเน่ืองมาจากการผสมของยานพาหนะ 
        ประเภท i ในสภาวะ j  

0d   =     ความล่าชา้เฉล่ียพื้นฐานของรถยนตน์ัง่ส่วนบุคคล 

ความล่าชา้ท่ีเปล่ียนแปลงไปอนัเน่ืองมาจากการผสมของยานพาหนะประเภท i ในสภาวะ j ( ijd ) 
สามารถวิเคราะห์ไดจ้ากความล่าชา้จากผลของแบบจาํลองสภาพจราจรดงัแสดงเป็นสมการณ์ทาง
คณิตศาสตร์ไดด้งัน้ี 

      ijijkijk VDDd /0              (3-3)
   
โดยท่ี 

ijkD    =  ความล่าชา้ทั้งหมดอนัเน่ืองมาจากการผสมของยานพาหนะประเภท i ใน 
    สภาวะ j และ k (หน่วยเป็น วินาที/คนั) 

jD0   =  ความล่าชา้ทั้งหมดในกรณีท่ีกระแสจราจรท่ีมีแต่รถยนตน์ัง่ส่วนบุคคลใน 
   สภาวะ j (หน่วยเป็น วินาที/คนั) 

iV   =  จาํนวนยวดยานของยานพาหนะประเภท i (หน่วยเป็น คนั/ชัว่โมง) 

3.9  สรุป 

เน้ือหาในบทน้ี ไดน้าํเสนอรายละเอียดและขั้นตอนในการดาํเนินการวิจยั โดยเร่ิมจากการ
คดัเลือกพื้นท่ีศึกษาซ่ึงไดท้าํการเลือกทางแยกทั้ง 9 ทางแยกแลว้จึงไดท้าํการสร้างแบบจาํลองสภาพ
จราจรของทางแยกดงักล่าวโดยไดมี้การสอบเทียบและทวนสอบแบบจาํลองเพ่ือให้แบบจาํลอง
สะทอ้นถึงสภาพจราจร และพฤติกรรมการขบัข่ีในแบบจาํลองท่ีมีใกลเ้คียงกบัสภาพความเป็นจริง 
จากนั้นจึงเขา้สู่ขั้นตอนการนาํขอ้มูลในแบบจาํลองสภาพปัจจุบนัมาสร้างและพฒันาเป็นแบบจาํลอง
ในสถานการณ์ต่างๆ เพื่อนาํมาพิจารณาถึงความล่าชา้ท่ีเกิดข้ึนจากยานพาหนะประเภทต่างๆ ภายใต้
สถานการณ์ต่างจากนั้นจึงนาํผลท่ีได้จากแบบจาํลองมาวิเคราะห์หาค่าเทียบเท่ารถยนต์นั่งส่วน
บุคคลจากความล่าชา้ ซ่ึงผลแบบจาํลอง และค่าเทียบเท่ารถยนตน์ัง่ส่วนบุคคลท่ีไดจ้ะถูกนาํเสนอใน
บทท่ี 4 


